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Disclaimers
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Some software products marketed by SAP SE and its distributors contain proprietary software 
components of other software vendors.
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inaccuracies.
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without representation or warranty of any kind, and SAP SE or its affiliated companies shall not be liable 
for errors or omissions with respect to the materials. The only warranties for SAP SE or SAP affiliate 
company products and services are those that are set forth in the express warranty statements 
accompanying such products and services, if any. Nothing herein should be construed as constituting an 
additional warranty.

In particular, SAP SE or its affiliated companies have no obligation to pursue any course of business 
outlined in this document or any related presentation, or to develop or release any functionality 
mentioned therein. This document, or any related presentation, and SAP SE’s or its affiliated companies’ 
strategy and possible future developments, products, and/or platform directions and functionality are 
all subject to change and may be changed by SAP SE or its affiliated companies at any time for any 
reason without notice. The information in this document is not a commitment, promise, or legal 
obligation to deliver any material, code, or functionality. All forward-looking statements are subject to 
various risks and uncertainties that could cause actual results to differ materially from expectations. 
Readers are cautioned not to place undue reliance on these forward-looking statements, which speak 
only as of their dates, and they should not be relied upon in making purchasing decisions.
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Typographic Conventions

American English is the standard used in this handbook.

The following typographic conventions are also used.

This information is displayed in the instructor’s presentation

Demonstration

Procedure

Warning or Caution

Hint

Related or Additional Information

Facilitated Discussion

User interface control Example text

Window title Example text
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Unit 1
Exercise 1

Access the SAP S/4HANA Cloud Public Edition 
Free Trial

Access the SAP S/4HANA Cloud Public Edition Trial System

1. Navigate to the SAP S/4HANA Cloud Public Edition trial website.

2. Click the button Try now to start your free 14-day trial.

3. Follow the instructions to get your account created.

Note:
It might take some time until your account is set up and you receive your 
confirmation email.

4. Open your email and select the link provided to access the home page of the trial system.

5. Navigate to the Trial Center section and review both the Introduction and the Trial 
Information to get a general understanding of the basic functions, the sample data model, 
and navigation of SAP S/4HANA Cloud Public Edition.

6. Choose the Guided Tours tile and complete the role-based guided tours to get an 
experience of a "day in the life" of different business users, if not done already in the 
previous step.

© Copyright. All rights reserved. 1

https://www.sap.com/products/erp/s4hana/trial.html


Unit 1
Solution 1

Access the SAP S/4HANA Cloud Public Edition 
Free Trial

Access the SAP S/4HANA Cloud Public Edition Trial System

1. Navigate to the SAP S/4HANA Cloud Public Edition trial website.

2. Click the button Try now to start your free 14-day trial.

3. Follow the instructions to get your account created.

Note:
It might take some time until your account is set up and you receive your 
confirmation email.

4. Open your email and select the link provided to access the home page of the trial system.

5. Navigate to the Trial Center section and review both the Introduction and the Trial 
Information to get a general understanding of the basic functions, the sample data model, 
and navigation of SAP S/4HANA Cloud Public Edition.

6. Choose the Guided Tours tile and complete the role-based guided tours to get an 
experience of a "day in the life" of different business users, if not done already in the 
previous step.

© Copyright. All rights reserved. 2

https://www.sap.com/products/erp/s4hana/trial.html


Unit 1
Exercise 2

Assign a Business Role

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Assign Business Role
In this exercise, you will learn how to assign your user an existing SAP-delivered business role.

1. Log into the SAP S/4HANA Cloud Public Edition training system with your user 
credentials and assign the following business role to your user:

● Administrator (BR_ADMINISTRATOR)
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Unit 1
Solution 2

Assign a Business Role

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Assign Business Role
In this exercise, you will learn how to assign your user an existing SAP-delivered business role.

1. Log into the SAP S/4HANA Cloud Public Edition training system with your user 
credentials and assign the following business role to your user:

● Administrator (BR_ADMINISTRATOR)

a) Use the Search to find and select the Maintain Business Users application.

b) Use the search field and/or filters to find your own user.

c) Select your business user from the list in order to enter its details page.

d) In the Assigned Business Roles section, select Add.

e) Use the keyword search to find the business role listed in the exercise.

f) Select the checkbox next to the relevant business role and choose Apply.

g) Select Cancel to close the dialog box.

h) Select the Save button in the lower right corner.

i) Refresh your browser (CTRL+R).

j) Select the SAP logo in the top left corner to navigate home.
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Unit 1
Exercise 3

Create a Custom Business Role with a Custom 
Launchpad Space and Page

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Create a Custom Business Role from a Template and Assign to your Business 
User
In this exercise, you will create a custom business role from an SAP-delivered template and 
assign the role to your business user.

1. Create a custom business role from a template with the following information:

● Template: Business Process Specialist (SAP_BR_BUSINESS_PROCESS_SPEC)

● New Business Role ID: BR_BUSINESS_PROCESS_SPEC_### (where ### is your 
group number)

● New Business Role Description: Business Process Specialist ###

● Option for Spaces: Create and Assign Spaces based on Predefined Spaces

● New Space ID: ZBR_BUSINESS_PROCESS_SPEC_### (delete any further rows, if 
necessary)

2. Change the Access Categories to Unrestricted.

3. Assign the custom role Business Process Specialist ### to your business user.
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Task 2: Create a Custom Launchpad Page
In this exercise, you will create a custom page with content and assign to your custom space 
created in the previous exercise.

1. Create a custom launchpad page with the following information:

● Page ID: ZBUS_SPECIALIST_### (where ### is your group number)

● Page Description: Business Process Specialist ###

● Page Title: Business Process Management ###

2. Enter the following page content for the new launchpad page:

● Section Title: Responsibility Management

● App: Manage Teams and Responsibilities

3. Assign the custom launchpad page to your custom launchpad space 
ZBR_BUSINESS_PROCESS_SPEC_###.

Unit 1: Implementing SAP S/4HANA Cloud Public Edition for Consultants: Exercises
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Unit 1
Solution 3

Create a Custom Business Role with a Custom 
Launchpad Space and Page

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Create a Custom Business Role from a Template and Assign to your Business 
User
In this exercise, you will create a custom business role from an SAP-delivered template and 
assign the role to your business user.

1. Create a custom business role from a template with the following information:

● Template: Business Process Specialist (SAP_BR_BUSINESS_PROCESS_SPEC)

● New Business Role ID: BR_BUSINESS_PROCESS_SPEC_### (where ### is your 
group number)

● New Business Role Description: Business Process Specialist ###

● Option for Spaces: Create and Assign Spaces based on Predefined Spaces

● New Space ID: ZBR_BUSINESS_PROCESS_SPEC_### (delete any further rows, if 
necessary)

a) Select the drop-down menu for the Administration space and choose the Identity and 
Access Management page.

b) Open the Maintain Business Roles app.
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c) Select Create From Template.

d) Enter the information listed in the exercise.

e) Select OK.

2. Change the Access Categories to Unrestricted.
a) On the General Role Details tab, change the access category for Write, Read, Value 

Help from No Access to Unrestricted.

3. Assign the custom role Business Process Specialist ### to your business user.
a) Select the Business Users tab.

b) Select Add.

c) Select your user from the list.

d) Select Apply.

e) Select OK or Cancel to close the dialog box.

f) Select Save in the lower right corner.

g) Refresh your browser (CTRL+R).

h) Select the SAP logo in the top left corner to navigate home.

Task 2: Create a Custom Launchpad Page
In this exercise, you will create a custom page with content and assign to your custom space 
created in the previous exercise.

1. Create a custom launchpad page with the following information:

● Page ID: ZBUS_SPECIALIST_### (where ### is your group number)

● Page Description: Business Process Specialist ###

● Page Title: Business Process Management ###

a) Select the drop-down menu for the Administration space and choose the Launchpad 
page.

b) Open the Manage Launchpad Pages app.

c) Select Create.

d) Enter the information in the exercise and choose Create.

Note:
In case of posting issues consider cleaning your browser cache first and 
repeat.

2. Enter the following page content for the new launchpad page:

● Section Title: Responsibility Management

● App: Manage Teams and Responsibilities

Unit 1: Implementing SAP S/4HANA Cloud Public Edition for Consultants: Exercises
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a) Select Edit in the top right corner.

b) Enter the section title listed in the exercise.

c) Select the three dots on the far right, then choose Select Catalogs.

d) Search for the Responsibility Management - Teams (SAP_CA_BC_RSM_PC) catalog.

e) Select the checkbox for the catalog and choose Select.

f) The Manage Teams and Responsibilities app should now be visible. Select the 
checkbox for the app and choose Add → Add as Tile (preferred).

g) Select Save in the lower right corner.

3. Assign the custom launchpad page to your custom launchpad space 
ZBR_BUSINESS_PROCESS_SPEC_###.
a) Select the Space Assignment tab.

b) Select Manage Launchpad Spaces in the upper right area.

c) You should be on the Customer-Created tab.

d) Use the keyword search to find your custom space 
(ZBR_BUSINESS_PROCESS_SPEC_###).

e) Select the space in order to view the details.

f) You should be on the Pages tab. Select the Edit button in the upper right area.

g) Use the keyword search to find the page you previously created 
(ZBUS_SPECIALIST_###)

h) Select the checkbox for the page and choose Add.

i) Select Save in the lower right corner.

j) Select the Back button in the top left corner twice. You should see there is now a Space 
Assignment for your page.

k) Refresh your browser (CTRL+R).

l) Select the SAP Logo in the top left corner to navigate home.

m) Select the Business Process Management ### space to view the custom page and 
assigned app.

Solution 3: Create a Custom Business Role with a Custom Launchpad Space and Page
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Unit 1
Exercise 4

Create Teams and Responsibilities

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Create a Team
In this exercise, you will create a team that will be granted specific permissions.

1. Open the Manage Teams and Responsibilities app and create a new team with the 
information below.

● Name: TEAM ### (where ### is your user number)

● Global ID: will populate automatically

● Type: DUMMY

● Status: Enabled

Note:
Don't get puzzled if an error message occurs - you will take care of it in the 
subsequent step.

2. Define responsibility for the organizational units listed below.

● DummyPlant: Plant 1 DE (1010)

3. Assign any team members (minimum 2).
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4. Assign functions to selected team members.

5. Save the team by choosing Create.

6. Navigate back to the home page.

Task 2: Create a Subteam and Manage Hierarchies
In this exercise, you will create a subteam for the team previously created, then review the 
overall hierarchy.

1. Open the Manage Teams and Responsibilities app in the role of a Business Process 
Specialist.

2. Create a Subteam for the team created in the previous exercise with the information 
below.

● Name: SUBTEAM ### (where ### is your user number)

● Global ID: will populate automatically

● Type: DUMMY

● Status: Enabled

Note:
The Responsibility Definitions and Team Owners will be copied from the Super 
Team.

Note:
Don't get puzzled if an error message occurs - you will take care of it in the 
subsequent step.

3. Assign any team members (minimum 2). Choose team members that are not on the super 
team created in the previous exercise.

4. Assign functions to selected team members.

5. Save the subteam by choosing Create and navigate back to the Manage Teams and 
Responsibilities app landing page.

Exercise 4: Create Teams and Responsibilities
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Unit 1
Solution 4

Create Teams and Responsibilities

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Create a Team
In this exercise, you will create a team that will be granted specific permissions.

1. Open the Manage Teams and Responsibilities app and create a new team with the 
information below.

● Name: TEAM ### (where ### is your user number)

● Global ID: will populate automatically

● Type: DUMMY

● Status: Enabled

Note:
Don't get puzzled if an error message occurs - you will take care of it in the 
subsequent step.

a) Select the Business Process Management tab with the Business Process Management 
### space towards the top of your screen.

b) Select the Manage Teams and Responsibilities app.

c) Select Create in the upper right area.
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d) Enter the information listed in the exercise.

2. Define responsibility for the organizational units listed below.

● DummyPlant: Plant 1 DE (1010)

a) Enter the information listed in the exercise for the relevant fields.

b) Confirm with OK.

3. Assign any team members (minimum 2).
a) Scroll down to the Team Members section.

b) Select Create.

c) Select the checkboxes next to any users you'd like, then select OK.

d) Note: Don't get puzzled if an error message occurs - you will take care of it in the next 
step.

4. Assign functions to selected team members.
a) In the Team Members section, select the checkbox(es) next to team members and 

select Manage Functions.

b) Confirm with OK.

c) In the Functions column, select both available functions for each selected team 
member, then select OK each.

5. Save the team by choosing Create.
a) Select Create in the lower right corner.

6. Navigate back to the home page.
a) Select the SAP button in the upper left corner to return to the home page.

Task 2: Create a Subteam and Manage Hierarchies
In this exercise, you will create a subteam for the team previously created, then review the 
overall hierarchy.

1. Open the Manage Teams and Responsibilities app in the role of a Business Process 
Specialist.
a) Select the Business Process Management tab towards the top of your screen and 

choose the Business Process Management ### space.

b) Open the Manage Teams and Responsibilities app.

2. Create a Subteam for the team created in the previous exercise with the information 
below.

● Name: SUBTEAM ### (where ### is your user number)

● Global ID: will populate automatically

● Type: DUMMY

● Status: Enabled

Solution 4: Create Teams and Responsibilities
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Note:
The Responsibility Definitions and Team Owners will be copied from the Super 
Team.

Note:
Don't get puzzled if an error message occurs - you will take care of it in the 
subsequent step.

a) Select the > icon at the right end of the line of the Team you created in the previous 
exercise.

b) Select Create Subteam in the upper right corner.

c) Enter the data listed in the exercise in the relevant fields.

3. Assign any team members (minimum 2). Choose team members that are not on the super 
team created in the previous exercise.
a) Scroll down to the Team Members section.

b) Select Create.

c) Select the checkboxes next to any users you'd like, then select OK.

d) Note: Don't get puzzled if an error message occurs - you will take care of it in the next 
step.

4. Assign functions to selected team members.
a) In the Team Members section, select the checkbox(es) next to team members and 

select Manage Functions.

b) Confirm with OK.

c) In the Functions column, select both available functions for each selected team 
member, then select OK each.

5. Save the subteam by choosing Create and navigate back to the Manage Teams and 
Responsibilities app landing page.
a) Select Create in the lower right corner to save your edits.

b) Select the Back button in the upper left corner twice to get back to the Manage Teams 
and Responsibilities app landing page.

Unit 1: Implementing SAP S/4HANA Cloud Public Edition for Consultants: Exercises
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Unit 1
Exercise 5

Create Business Users

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Verify Launchpad Space is Assigned to Business Role & Assign Role to User
In this exercise, you will verify a launchpad space is assigned to the business role you will use 
in this exercise. When the Spaces and Pages home page is enabled, each business role must 
have an assigned launchpad space. Without a launchpad space, no apps will display on the 
launchpad for a user.

1. Verify there is a standard launchpad space assigned to the business role below and assign 
the role to your user.

● Administrator - HR Info (BR_ADMINISTRATOR_HRINFO)

Task 2: Download and Populate the Import File
You will export the employee data template and populate the template with test users. This is 
how consultants create test users to demonstrate the business process flows (scope items) 
during the Fit-to-Standard Workshops. Customers that participated in the workshops will 
then use these same test users to work through the test processes they saw demonstrated in 
their workshop(s) to get familiar with the SAP S/4HANA Cloud Public Edition system.

1. Download the employee data file from the Manage Workforce application.

2. Open the template in Microsoft Excel and enter the following user data:
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Note:
Simply replace/overwrite any existing sample entries in the Excel template 
with the subsequent data.

User *WorkerI
D

UserNam
e

*Worker
Type

Is 
Continge
nt 
Worker 
of

*FirstNa
me

*LastNa
me

FullName

1 E1234##
#

pmanage
r###

BUP003 (Leave 
blank)

Project Manager 
(###)

Project 
Manager 
(###)

2 E1235##
#

caccount
ant###

BUP003 (Leave 
blank)

Cost Accounta
nt (###)

Cost 
Accounta
nt (###)

3 E1236##
#

rmanage
r###

BUP003 (Leave 
blank)

Resource Manager 
(###)

Resource 
Manager 
(###)

User Email PhoneN
umber

MobileP
honeNu
mber

Langua
ge

*Compa
nyCode

CostCe
nter

*StartD
ate

*EndDa
te

1 pm1@c
ompany
.com

(Leave 
blank)

(Leave 
blank)

EN 1010 1010150
1

Today's 
date 
YYYYM
MDD

999912
31

2 ca1@co
mpany.
com

(Leave 
blank)

(Leave 
blank)

EN 1010 1010150
1

Today's 
date 
YYYYM
MDD

999912
31

3 rm1@co
mpany.
com

(Leave 
blank)

(Leave 
blank)

EN 1010 1010150
1

Today's 
date 
YYYYM
MDD

999912
31

File name and type when you save: BasicEmployeeDataTemplate###.csv (where ### 
is your user number)

Unit 1: Implementing SAP S/4HANA Cloud Public Edition for Consultants: Exercises
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Note:
Ensure to save it in the "Comma delimited CSV" format - DO NOT save it in a 
"Comma delimited UTF-8 CSV" format. Confirm any warnings while saving the 
CSV file.

3. Use the Manage Workforce application to import the template with the following 
information:

● Worker and Work Agreement Data: <Your template>

● Import Name: Test User File ### (where ### is your user number)

Task 3: Validate Business User Creation
You will verify the business users were successfully created. During Fit-to-Standard 
workshops, consultants can follow this process to create test users that correspond to the 
roles used in each business process test script. You would assign one business role per test 
user (e.g. Project Manager-Professional Services would be assigned the Project Manager-
Professional Services business role) to allow consultants to give a clear demonstration of the 
applications and functionality the role has access to. After the workshops, the customer 
experts are encouraged to test out scenarios they saw demonstrated in the workshops using 
these same test users in the Starter System.

1. Use the Maintain Business Users application to search for following users with the User 
Name filter field:

User Name Business Role

pmanager### Project Manager - Professional Services

caccountant### Cost Accountant - Overhead

rmanager### Resource Manager

Exercise 5: Create Business Users
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Unit 1
Solution 5

Create Business Users

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Verify Launchpad Space is Assigned to Business Role & Assign Role to User
In this exercise, you will verify a launchpad space is assigned to the business role you will use 
in this exercise. When the Spaces and Pages home page is enabled, each business role must 
have an assigned launchpad space. Without a launchpad space, no apps will display on the 
launchpad for a user.

1. Verify there is a standard launchpad space assigned to the business role below and assign 
the role to your user.

● Administrator - HR Info (BR_ADMINISTRATOR_HRINFO)

a) Log into the SAP S/4HANA Cloud Public Edition system with your user credentials.

b) Select the Administration drop-down menu in the upper left and choose the Identity 
and Access Management page.

c) Open the Maintain Business Roles app.

d) Use the search to find the business role listed in the exercise.

e) Select the business role to open its detail page.

f) Select the Launchpad Spaces tab to confirm a space is assigned.

g) Select the back button in the top left corner twice to navigate back to the Identity and 
Access Management page.
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h) Select the Maintain Business Users app.

i) Select your user from the list in order to open its details.

j) Select the Add button.

k) Use the keyword search to find the Administrator - HR Info 
(BR_ADMINISTRATOR_HRINFO) role from the lsit.

l) Select the checkbox next to the role and choose Apply.

m) Select Cancel to close the dialog box.

n) Select Save in the lower right corner.

o) Refresh your browser (CTRL+R).

p) Select the SAP logo in the top left corner to navigate home.

Task 2: Download and Populate the Import File
You will export the employee data template and populate the template with test users. This is 
how consultants create test users to demonstrate the business process flows (scope items) 
during the Fit-to-Standard Workshops. Customers that participated in the workshops will 
then use these same test users to work through the test processes they saw demonstrated in 
their workshop(s) to get familiar with the SAP S/4HANA Cloud Public Edition system.

1. Download the employee data file from the Manage Workforce application.
a) Select the Administration - HR Info space.

b) Select the Manage Workforce application.

c) Select Import in the upper right area, then choose Worker and Work Agreement (Basic 
Import) from the drop-down list.

d) Select the radio button for the Comma (,) delimiter.

e) Select Download Templates to save the file to your local Downloads folder.

f) Select Close to close the dialog box.

2. Open the template in Microsoft Excel and enter the following user data:

Note:
Simply replace/overwrite any existing sample entries in the Excel template 
with the subsequent data.

User *WorkerI
D

UserNam
e

*Worker
Type

Is 
Continge
nt 
Worker 
of

*FirstNa
me

*LastNa
me

FullName

1 E1234##
#

pmanage
r###

BUP003 (Leave 
blank)

Project Manager 
(###)

Project 
Manager 
(###)

Solution 5: Create Business Users

© Copyright. All rights reserved. 19



User *WorkerI
D

UserNam
e

*Worker
Type

Is 
Continge
nt 
Worker 
of

*FirstNa
me

*LastNa
me

FullName

2 E1235##
#

caccount
ant###

BUP003 (Leave 
blank)

Cost Accounta
nt (###)

Cost 
Accounta
nt (###)

3 E1236##
#

rmanage
r###

BUP003 (Leave 
blank)

Resource Manager 
(###)

Resource 
Manager 
(###)

User Email PhoneN
umber

MobileP
honeNu
mber

Langua
ge

*Compa
nyCode

CostCe
nter

*StartD
ate

*EndDa
te

1 pm1@c
ompany
.com

(Leave 
blank)

(Leave 
blank)

EN 1010 1010150
1

Today's 
date 
YYYYM
MDD

999912
31

2 ca1@co
mpany.
com

(Leave 
blank)

(Leave 
blank)

EN 1010 1010150
1

Today's 
date 
YYYYM
MDD

999912
31

3 rm1@co
mpany.
com

(Leave 
blank)

(Leave 
blank)

EN 1010 1010150
1

Today's 
date 
YYYYM
MDD

999912
31

File name and type when you save: BasicEmployeeDataTemplate###.csv (where ### 
is your user number)

Note:
Ensure to save it in the "Comma delimited CSV" format - DO NOT save it in a 
"Comma delimited UTF-8 CSV" format. Confirm any warnings while saving the 
CSV file.

a) Start MS Excel with an empty sheet, choose the Data tab and use the Get Data from 
CSV file function to import/load the template and data. Confirm any information 
messages in Excel. (Alternatively, you can simply open the file in Excel and follow the 
import wizard).

b) Enter the data listed in the exercise by overwriting any existing entries. Remember to 
enter your user number when you see ###.

c) Select File → Save As in Excel.

Unit 1: Implementing SAP S/4HANA Cloud Public Edition for Consultants: Exercises
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d) Select the Downloads folder to save your file in "Comma delimited CSV" format and 
add your user number to the file name: BasicEmployeeDataTemplate###.csv. Note: 
DO NOT save it in a "Comma delimited UTF-8 CSV" format.

e) Select Save. Confirm any warnings while doing so, if necessary.

f) Close Excel.

3. Use the Manage Workforce application to import the template with the following 
information:

● Worker and Work Agreement Data: <Your template>

● Import Name: Test User File ### (where ### is your user number)

a) In the Manage Workforce application, select Import in the upper right area, then 
choose Worker and Work Agreement (Basic Import) from the drop-down list (only if the 
dialog box was not already open on the page from the previous exercise).

b) In the Delimiter field, select Semicolon (;).

c) In the Worker and Work Agreement Data field, select Browse... and choose your file 
BasicEmployeeDataTemplate###.csv.

d) In the Import Name field, enter the name listed in the exercise information.

e) Select Import.

f) Select Close to close the dialog box.

g) Select Show Application Log to confirm the import has been successful.

h) Select the SAP logo in the top left corner to navigate home.

Task 3: Validate Business User Creation
You will verify the business users were successfully created. During Fit-to-Standard 
workshops, consultants can follow this process to create test users that correspond to the 
roles used in each business process test script. You would assign one business role per test 
user (e.g. Project Manager-Professional Services would be assigned the Project Manager-
Professional Services business role) to allow consultants to give a clear demonstration of the 
applications and functionality the role has access to. After the workshops, the customer 
experts are encouraged to test out scenarios they saw demonstrated in the workshops using 
these same test users in the Starter System.

1. Use the Maintain Business Users application to search for following users with the User 
Name filter field:

User Name Business Role

pmanager### Project Manager - Professional Services

caccountant### Cost Accountant - Overhead

rmanager### Resource Manager

a) Select the Administration drop-down menu in the upper left and choose the Identity 
and Access Management page.

Solution 5: Create Business Users
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b) Select the Maintain Business Users application.

c) Search for a user listed in the exercise with the User Name field.

d) Select the Go button.

e) Select the user or choose the > icon at the right end of the line.

f) In the Assigned Business Roles section, select Add.

g) Use the Search field to find the business role that corresponds to the user.

h) Select the checkbox to the left of the business role.

i) Select the Apply button.

j) Close the dialog box.

k) Select the Save button in the lower right corner to save the user.

l) Repeat substeps (b) through (l) until all new users have the corresponding business 
roles assigned.

m) Refresh your browser (CTRL+R).

n) Select the SAP logo in the top left corner to navigate home.

Unit 1: Implementing SAP S/4HANA Cloud Public Edition for Consultants: Exercises
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Unit 1
Exercise 6

Define Restrictions for a Business Role

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Create a Business Role from a Template
You will create a new business role from an existing business role template.

1. Use the Maintain Business Roles application to create a business role with the following 
information:

● Template: Project Manager - Professional Services 
(SAP_BR_PROJECT_MANAGER_PROF)

● New Business Role ID: BR_PROJECT_MANAGER_PROF_DE_### (where ### is your user 
number)

● New Business Role Description: Project Manager - Professional Services 
(DE) ### (where ### is your user number)

● Option for Spaces: Create and Assign Spaces Based on Predefined Spaces.

● New Space ID: ZBR_PROJECT_MANAGER_PROF_###

Note:
Do NOT select the Save button yet.
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Task 2: Define Restrictions
You will define restrictions for the role using parameters related to the organizational 
structure. If we do not restrict data access, a user with a business role assigned will be able to 
access all data in the applications on their launchpad. It may be necessary to restrict visibility 
to data for users based on certain parameters. To do this, you must create a business role for 
each restriction area (for example, Project Manager (USA), Project Manager (DE), etc.) by 
either creating a custom role and copying the role, copying a standard role, or creating a role 
from a standard template. You will create a role from a standard template in this exercise.

1. Maintain the following restrictions for the Project Manager - Professional Services (DE) 
### business role:

● Write, Read, Value Help: No Access

2. Define the following Read, Value Help restrictions for the Project Manager - Professional 
Services (DE) ### business role:
Read, Value Help: Restricted

Section Field Restriction Value

General Bank Country/Region Key DE

General Company Code 1010

General Purchasing Organization 1010

3. Define the following Value Help restrictions for the Project Manager - Professional Services 
(DE) ### business role:
Value Help: Unrestricted

4. Review the restrictions applied to the Professional Services Projects - Customer Project 
Display (SAP_PSP_BC_CUST_PROJ_DISP_PC) Business Catalog.

Note:
You may complete sub steps (c) through (g) for the remaining business 
catalogs to view the Restrictions, Catalog Description, and Applications for 
each catalog.

5. Assign the new Business Role to your business user.

Unit 1: Implementing SAP S/4HANA Cloud Public Edition for Consultants: Exercises
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Unit 1
Solution 6

Define Restrictions for a Business Role

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Create a Business Role from a Template
You will create a new business role from an existing business role template.

1. Use the Maintain Business Roles application to create a business role with the following 
information:

● Template: Project Manager - Professional Services 
(SAP_BR_PROJECT_MANAGER_PROF)

● New Business Role ID: BR_PROJECT_MANAGER_PROF_DE_### (where ### is your user 
number)

● New Business Role Description: Project Manager - Professional Services 
(DE) ### (where ### is your user number)

● Option for Spaces: Create and Assign Spaces Based on Predefined Spaces.

● New Space ID: ZBR_PROJECT_MANAGER_PROF_###

a) Open the Maintain Business Roles application under Administration - Identity and 
Access Management (not the app with "Deprecated" in the title).

b) Select Create From Template .

c) Enter the information listed in the exercise and select OK.
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Note:
Do NOT select the Save button yet.

Task 2: Define Restrictions
You will define restrictions for the role using parameters related to the organizational 
structure. If we do not restrict data access, a user with a business role assigned will be able to 
access all data in the applications on their launchpad. It may be necessary to restrict visibility 
to data for users based on certain parameters. To do this, you must create a business role for 
each restriction area (for example, Project Manager (USA), Project Manager (DE), etc.) by 
either creating a custom role and copying the role, copying a standard role, or creating a role 
from a standard template. You will create a role from a standard template in this exercise.

1. Maintain the following restrictions for the Project Manager - Professional Services (DE) 
### business role:

● Write, Read, Value Help: No Access

a) In the Project Manager - Professional Services (DE) ### business role, select Maintain 
Restrictions in the upper right area (not the one with "Deprecated" in the title).

b) By default when a new role is created, Write access is No Access. Leave this as-is.

2. Define the following Read, Value Help restrictions for the Project Manager - Professional 
Services (DE) ### business role:
Read, Value Help: Restricted

Section Field Restriction Value

General Bank Country/Region Key DE

General Company Code 1010

General Purchasing Organization 1010

a) In the Read, Value Help section, change Unrestricted to Restricted by selecting 
Restricted from the drop-down menu.

b) In the General section, select the checkbox next to the Restrictions and Values text in 
the upper left area to select all values.

c) Select the Unrestricted Access link in the upper right area.

d) When prompted if you want to assign unrestricted access to the undefined fields, 
select Yes.
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Note:
When you set Write, Read, or Value Help to "Restricted", you must define a 
restriction for ALL sections, even if that restriction is Unrestricted (*). If 
you only define restrictions for specific fields within section(s) and leave all 
other fields blank, users will have NO ACCESS to those fields. We 
recommend first setting all fields to Unrestricted, then selectively setting 
restrictions for specific fields as needed (e.g. Company Code restricted to 
1010, meaning users with this business role only have access to project 
management data in the 1010 company code).

e) Find each value listed in the exercise information.

f) Select the edit icon to the far right of the value field (e.g. Bank Country/Region Key).

g) In the Field Settings, select the radio button Restricted.

h) In the Values area, select the checkbox for the restriction value listed in the exercise 
information (e.g. DE).

i) The screen will automatically save your selection. Select the X button in the top right 
corner of the Restrictions for... section to close the section.

j) Repeat sub steps (e) through (i) until you have defined the restrictions for all fields 
listed in the exercise information.

3. Define the following Value Help restrictions for the Project Manager - Professional Services 
(DE) ### business role:
Value Help: Unrestricted
a) By default when a new role is created, Value Help access is Unrestricted. Leave this as-

is.

b) Select the Back button in the top left corner.

c) Select the Save button in the bottom right corner.

4. Review the restrictions applied to the Professional Services Projects - Customer Project 
Display (SAP_PSP_BC_CUST_PROJ_DISP_PC) Business Catalog.
a) Select the Business Catalogs tab.

b) Select the Business Catalog Professional Services Projects - Customer Project Display 
(SAP_PSP_BC_CUST_PROJ_DISP_PC) or select the > button at the right end of the line 
in order to navigate to the details.

c) On the Restrictions page, you can see the restrictions that will be applied for the 
applications/functionality/data granted in the catalog.

d) Select the Catalog Description section to view general information about the Business 
Catalog and restriction recommendations.

e) Select the Applications tab see the application(s) a user will have restricted data 
access for.

f) Select the Back button in the top left corner.

Solution 6: Define Restrictions for a Business Role
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Note:
You may complete sub steps (c) through (g) for the remaining business 
catalogs to view the Restrictions, Catalog Description, and Applications for 
each catalog.

5. Assign the new Business Role to your business user.
a) Select the Business Users tab.

b) Select the Edit button.

c) Select the Add button.

d) Select the checkbox next to your user, then select Apply.

e) Select OK.

f) Select the Save button in the lower right.

g) Refresh your browser (CTRL+R).

h) Select the SAP logo in the upper left corner to navigate home and view new 
applications on your launchpad.
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Unit 1
Exercise 7

Set up an Integration Scenario

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Access the SAP Best Practices for the Situation Handling (31N) Integration
You will access and download the SAP Best practices set-up instructions for the Situation 
Handling (31N) integration.

1. Navigate to SAP Process Navigator and download the set-up instructions to complete the 
Situation Handling (31N) integration.

Task 2: Create a Communication User
You will complete the first step of setting up a communication arrangement in SAP S/4HANA 
Cloud Public Edition, which is to create a communication user that defines the authentication 
for a communication arrangement.

1. Use the Maintain Communication Users application to create a new user with the following 
information:

● User name: COMM_USER_### (where ### is your user number)

● Description: Integration User for Situation Handling ### (where ### is 
your user number)

● Password: Select the Propose Password button

Task 3: Create a Communication System
In this exercise, you will create a communication system and attach the communication user 
to the system for authentication. The communication system will then be used in the final 
communication arrangement.
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1. Use the Communication Systems application to create a new communication system with 
the following information:

● System ID: COMM_SYSTEM_### (where ### is your user number)

● System Name: Communication System for Situation Handling ### (where 
### is your user number)

2. Enter the following information for the Communication System and save:

● Host Name: DUMMY

● User for Inbound Communication: Select your COMM_USER_### created in 
the previous exercise

Task 4: Create a Communication Arrangement
You will create the communication arrangement to activate the integration for the Situation 
Handling (31N) scope item.

1. Use the Communication Arrangements application to create a new user with the following 
information:

● Scenario: SAP_COM_0345 Business Situation

● Arrangement Name: SAP_COM_0345_### (where ### is your user number)

2. Enter the following information for the Communication Arrangement and save:

● Communication System: COMM_SYSTEM_### (where ### is your user number) 
created in the previous exercise

3. Delete the communication arrangement.
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Unit 1
Solution 7

Set up an Integration Scenario

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Access the SAP Best Practices for the Situation Handling (31N) Integration
You will access and download the SAP Best practices set-up instructions for the Situation 
Handling (31N) integration.

1. Navigate to SAP Process Navigator and download the set-up instructions to complete the 
Situation Handling (31N) integration.
a) Navigate to the Situation Handling (31N) business process in SAP Process Navigator.

Note:
In case you encounter issues accessing the link, please choose Google 
Chrome for your browser.

b) Select the link for the Accelerators section (or scroll down).

c) Select the Set-up instructions and save the file to your desktop. You may use the set-
up instructions as a reference while completing the following exercises, as the 
exercises are based on the steps of the set-up instructions.

Task 2: Create a Communication User
You will complete the first step of setting up a communication arrangement in SAP S/4HANA 
Cloud Public Edition, which is to create a communication user that defines the authentication 
for a communication arrangement.
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1. Use the Maintain Communication Users application to create a new user with the following 
information:

● User name: COMM_USER_### (where ### is your user number)

● Description: Integration User for Situation Handling ### (where ### is 
your user number)

● Password: Select the Propose Password button

a) In the Administration drop-down menu, select the Communication Management page.

b) Open the Maintain Communication Users app.

c) Choose New to create a new user.

d) Enter the user information provided in the exercise.

e) Select Propose Password.

f) Choose Create in the lower right corner.

g) Select the SAP logo in the upper left corner to navigate home to the launchpad.

Task 3: Create a Communication System
In this exercise, you will create a communication system and attach the communication user 
to the system for authentication. The communication system will then be used in the final 
communication arrangement.

1. Use the Communication Systems application to create a new communication system with 
the following information:

● System ID: COMM_SYSTEM_### (where ### is your user number)

● System Name: Communication System for Situation Handling ### (where 
### is your user number)

a) In the Administration drop-down menu, select the Communication Management page.

b) Open the Communication Systems app.

c) Select New.

d) Enter the information listed in the exercise.

e) Select the Create button.

2. Enter the following information for the Communication System and save:

● Host Name: DUMMY

● User for Inbound Communication: Select your COMM_USER_### created in 
the previous exercise

a) Enter the information listed in the exercise in the Host Name field.

b) Scroll down to the User for Inbound Communication section.

c) Select the Plus (+) icon to add a new user.

d) Select your COMM_USER_### created in the previous exercise.
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e) Select OK to close the dialog box.

f) Select Save.

g) Select the SAP logo in the upper left corner to navigate home to the launchpad.

Task 4: Create a Communication Arrangement
You will create the communication arrangement to activate the integration for the Situation 
Handling (31N) scope item.

1. Use the Communication Arrangements application to create a new user with the following 
information:

● Scenario: SAP_COM_0345 Business Situation

● Arrangement Name: SAP_COM_0345_### (where ### is your user number)

a) In the Administration drop-down menu, select the Communication Management page.

b) Open the Communication Arrangements app.

c) Select New.

d) Enter the information listed in the exercise.

e) Select Create.

2. Enter the following information for the Communication Arrangement and save:

● Communication System: COMM_SYSTEM_### (where ### is your user number) 
created in the previous exercise

a) Select the Communication System field and choose your COMM_SYSTEM_### created 
in the previous exercise.

b) The User Name field should automatically populate with the communication user 
attached to the selected communication system.

c) Select Save in the lower right corner to activate the arrangement.

Note:
There can only be one active communication arrangement for this 
scenario. If multiple users are working through this exercise in the system, 
someone may have already activated this scenario. In this case, you may 
not be able to activate your communication arrangement.

3. Delete the communication arrangement.
a) Select the Back button in the upper left corner to navigate to the previous page listing 

all communication arrangements in the system.

b) Select the checkbox next to your communication arrangement.

c) Select the Delete button.

d) Select OK to confirm and use the SAP logo in the upper left corner to return to the 
main page.

Solution 7: Set up an Integration Scenario
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Unit 1
Exercise 8

Prepare to Migrate Data

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Assign Role to User for Migrating Data
In this exercise, you will assign the role required to access the app used to migrate data to 
SAP S/4HANA Cloud.

1. Assign the business role below to your user.

● Configuration Expert - Data Migration (BR_CONFIG_EXPERT_DATA_MIG)

Task 2: Identify Migration Object-Specific Authorization & Application for Validation
Additional permission is often required to migrate data for individual migration objects. You 
can find this information in the Available Migration Objects area of the SAP Help Portal here:

https://tinyurl.com/migration-objects-CL

1. Identify the following information for the Bank migration object:

● Business role template required for migration

● Application to validate data has been migrated successfully

Task 3: Assign Additional Role to User for Migrating Bank Data
You have just discovered you need the Cash Manager business role assigned to your user in 
addition to the Data Migration Configuration Expert to successfully migrate bank data. In this 
exercise, you will assign the Cash Manager role to your user.

1. Assign the business role below to your user.
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● Cash Manager (BR_CASH_MANAGER)

Exercise 8: Prepare to Migrate Data
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Unit 1
Solution 8

Prepare to Migrate Data

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Assign Role to User for Migrating Data
In this exercise, you will assign the role required to access the app used to migrate data to 
SAP S/4HANA Cloud.

1. Assign the business role below to your user.

● Configuration Expert - Data Migration (BR_CONFIG_EXPERT_DATA_MIG)

a) Select the Administration drop-down menu in the upper left and choose the Identity 
and Access Management page.

b) Open the Maintain Business Users app.

c) Use the search to find and select your user from the list in order to open its details 
page.

d) Select Add.

e) Use the search to find the role listed in the exercise.

f) Select the checkbox next to the role and choose Apply.

g) Select Cancel to close the dialog box.

h) Select Save in the lower right corner.

i) Refresh your browser (CTRL+R).
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j) Select the SAP logo in the top left corner to navigate home.

Task 2: Identify Migration Object-Specific Authorization & Application for Validation
Additional permission is often required to migrate data for individual migration objects. You 
can find this information in the Available Migration Objects area of the SAP Help Portal here:

https://tinyurl.com/migration-objects-CL

1. Identify the following information for the Bank migration object:

● Business role template required for migration

● Application to validate data has been migrated successfully

a) Navigate to the Available Migration Objects area in the SAP Help Portal: https://
tinyurl.com/migration-objects-CL

b) Select the Bank migration object.

c) Scroll down to the Post-Processing section.

Note:
The business role required for migration of the Bank object is Cash 
Manager (SAP_BR_CASH_MANAGER). You can verify this implementation 
information by navigating through the Cash Management Link given in the 
Post-Processing section to the SAP Fiori App Library. The application you 
can check to verify data has been successfully migrated is Manage Banks.

Task 3: Assign Additional Role to User for Migrating Bank Data
You have just discovered you need the Cash Manager business role assigned to your user in 
addition to the Data Migration Configuration Expert to successfully migrate bank data. In this 
exercise, you will assign the Cash Manager role to your user.

1. Assign the business role below to your user.

● Cash Manager (BR_CASH_MANAGER)

a) Select the Administration drop-down menu in the upper left and choose the Identity 
and Access Management page.

b) Open the Maintain Business Users app.

c) Use the search to find and select your user from the list.

d) Select Add.

e) Use the search to find the role listed in the exercise.

f) Select the checkbox next to the role and choose Apply.

g) Select Cancel to close the dialog box.

h) Select Save in the lower right corner.

i) Refresh your browser (CTRL+R).

j) Select the SAP logo in the top left corner to navigate home.

Solution 8: Prepare to Migrate Data
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Unit 1
Exercise 9

Migrate Data

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Create a New Migration Project
You will create a new migration project to prepare for migration of Bank data.

1. Create a new migration project with the following information:

● Name: Migrate Bank Data ### (where ### is your user number)

● Mass Transfer ID: Prepopulated

● Database Connection: Local SAP S/4HANA Database Schema

2. Copy the Bank migration object to your Migrate Bank Data ### project.

Task 2: Download the Bank Migration Template
You will download the Bank migration object template.

1. Download the Bank migration object template.

Task 3: Populate the Bank Migration Template
You will populate bank data in the migration template.

1. Open the Source Data for Bank.xml template in Microsoft Excel.

2. Populate the following data in the template (note, that ### refers to your user number):
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Bank country 
key*

Bank key* Name of bank* House number 
and street

City

CN 9601### ICBC, China ChenHui RD, 
1001

Shanghai

CN 9602### ICBC, China Main RD, 3002 Shanghai

CN 9603### ICBC, China PuDong RD, 
1003

Shanghai

3. Save the Source Data for Bank.xml template with your user number in the downloads 
folder (Source Data for Bank_###.xml).

Task 4: Upload the Migration Object Template and Transfer Data
You will upload the migration object template and transfer the data.

1. Upload the Source Data for Bank_###.xml template in your Migrate Bank Data ### 
project in SAP S/4HANA Cloud Public Edition with the following information:

● File Name: Source Data for Bank_###.xml

● Description: Migration of Bank Data ### (where ### is your user number.

2. Prepare the Migration Object staging tables.

3. Confirm the Mapping tasks when the Preparation task is completed.

4. Simulate the Migration.

5. Migrate the data when the Simulation task is completed.

Exercise 9: Migrate Data
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Unit 1
Solution 9

Migrate Data

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Create a New Migration Project
You will create a new migration project to prepare for migration of Bank data.

1. Create a new migration project with the following information:

● Name: Migrate Bank Data ### (where ### is your user number)

● Mass Transfer ID: Prepopulated

● Database Connection: Local SAP S/4HANA Database Schema

a) Select the Configuration - Data Migration space.

b) Open the Migrate Your Data - Migration Cockpit app (do not use the "Migrate Your Data 
- Migration Cockpit Deprecated" app).

c) Select the Create button and select the option Migrate Data Using Staging Tables.

d) Enter the information listed in the exercise and confirm the Name entry with Enter.

e) Select the Step 2 button.

2. Copy the Bank migration object to your Migrate Bank Data ### project.
a) Select the checkbox to the far left of the Bank object.

b) Select the button with the arrow pointing right (>).
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c) Select the Review button.

d) Select the Create Project button.

e) If you don't see a row with your migration project immediately, select the Refresh 
button in the upper right corner until it shows up.

Task 2: Download the Bank Migration Template
You will download the Bank migration object template.

1. Download the Bank migration object template.
a) Select the Migrate Bank Data ### project created in the previous exercise in order to 

navigate to its detail page.

b) In the Action menu (far right), select Download Template and choose XML file, then 
select OK, if necessary.

Note:
Depending on your internet browser, a download dialog box may appear. 
Download and save the template to your local computer. If no dialog box 
appears, the file is automatically saved in the Downloads folder.

c) Save the Source Data for Bank.xml file to your desktop or a folder of your preference. 
In the following steps, we assume you have saved the file in the Downloads folder.

Task 3: Populate the Bank Migration Template
You will populate bank data in the migration template.

1. Open the Source Data for Bank.xml template in Microsoft Excel.
a) Open the Microsoft Excel application on your computer.

b) Open a Blank workbook in Excel.

c) Select File → Open in Excel and choose Browse.

d) Select Downloads from the far left default entries.

e) Change the search extension to All Files (*.*)

f) Double-click the Source Data for Bank.xml template to open it.

Note:
Depending on your Microsoft Excel version you may receive a warning 
message that states Excel does not recognize the file format. Select OK to 
open the file anyway. The Migration Object downloads as an XML file, which 
can be opened by the Excel application.

2. Populate the following data in the template (note, that ### refers to your user number):

Solution 9: Migrate Data
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Bank country 
key*

Bank key* Name of bank* House number 
and street

City

CN 9601### ICBC, China ChenHui RD, 
1001

Shanghai

CN 9602### ICBC, China Main RD, 3002 Shanghai

CN 9603### ICBC, China PuDong RD, 
1003

Shanghai

a) If prompted by a Protected View warning, select the "Enable Editing" button in order to 
edit in the Excel sheet.

b) In the Source Data for Bank MS Excel sheet, select the Field List tab to view the field 
parameters and required fields.

c) Select the Bank Master tab and enter the information listed in the exercise.

Note:
You must always strip the formatting of data if you copy-paste data into 
the migration object XML templates. You can do this in Microsoft Excel by 
right clicking and selecting the Paste Option Values (V). You can also use a 
plain text tool such as Notepad to strip formatting of data before copy-
pasting from Notepad into the migration object template. If you paste data 
that has formatting into the migration object template, it will corrupt the 
XML file and you wil not be able to upload.

3. Save the Source Data for Bank.xml template with your user number in the downloads 
folder (Source Data for Bank_###.xml).
a) Select File → Save As in Microsoft Excel.

b) Select the Downloads folder.

c) Add your user number to the file name (Source Data for Bank_###.xml)

d) Select Save.

Note:
You will receive a message that states: Some features in your workbook 
might be lost if you save it as an XML Spreadsheet. Do you want to keep 
using that format? Select Yes to keep the template in XML format.

e) Close Excel.

Task 4: Upload the Migration Object Template and Transfer Data
You will upload the migration object template and transfer the data.

1. Upload the Source Data for Bank_###.xml template in your Migrate Bank Data ### 
project in SAP S/4HANA Cloud Public Edition with the following information:
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● File Name: Source Data for Bank_###.xml

● Description: Migration of Bank Data ### (where ### is your user number.

a) Navigate back to your browser where you should still be logged into SAP S/4HANA 
Cloud Public Edition and have your migration project open.

b) Select the Upload File button.

c) Select Upload file.

d) Select Upload.

e) Choose your file.

f) Select Open.

Note:
You will see a message that states: Validation Scheduled. After a few 
seconds, you should then see the message change to Data Successfully 
Transferred to Staging Tables. You may select Show Messages for 
additional information. In this case, select Back when done.

2. Prepare the Migration Object staging tables.
a) Select the Back button in the top left corner.

b) Select the Prepare button.

Note:
You can do this by selecting the Prepare button located in the Bank 
migration object (in this case select Prepare from the dropdown menu), or 
select the checkbox to the left of the Bank migration object, then choose 
the Actions menu → Prepare.

c) Read the information from the information window, select Consistency Check: On and 
Prepare Staging Tables.

d) Choose Monitoring in the header area to monitor the status of the preparation step. 
This shows you the estimated runtime and messages.

3. Confirm the Mapping tasks when the Preparation task is completed.
a) When the preparation step is completed, select the Back button in the top left corner.

b) Select the Mapping Tasks button.

Note:
You can do this by selecting the Mapping Tasks button located in the Bank 
migration object, or select the checkbox to the left of the Bank migration 
object, then choose the Actions menu > Mapping Tasks.

c) Select the second non-confirmed Mapping Task and choose > to its far right.

Solution 9: Migrate Data
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d) Review its S/4HANA Target Value.

e) Select the Confirm button of the first non-confirmed entry.

f) Confirm any further entries of this task accordingly, if necessary: Select the Back 
button in the top left corner.

g) Select the first Mapping Task , choose > again and instead of confirming each 
individually, choose the checkbox in the header to select all, then choose Confirm in 
the header area.

h) Select the Back button in the top left corner.

4. Simulate the Migration.
a) Select the Back button in the top left corner.

b) In the Migrate Bank Data ### migration object, select the Simulate button for your 
Bank migration object.

Note:
You can do this by selecting the Simulate button located in the Bank 
migration object (in this case choose Simulate from the dropdown menu), 
or select the checkbox to the left of the Bank migration object, then choose 
the Actions menu → Simulate.

c) In the New Simulation window choose All Instances and Start Simulation.

d) Choose Monitoring in the header area to monitor the status of the simulation step. This 
shows you the estimated runtime and messages.

5. Migrate the data when the Simulation task is completed.
a) When the simulation task is completed, select the Back button in the top left corner.

b) Select the Migrate button.

Note:
You can do this by selecting the drop-down menu located in the Bank 
migration object and choosing Migrate, or select the checkbox to the left of 
the Bank migration object, then choose the Actions menu > Migrate.

c) In the New Migration window choose All Instances and Start Migration.

d) Select OK to begin the migration. Note, that the system might ask you to wait until all 
running background processes are finished.

e) Choose Monitoring in the header area to monitor the status of the migration step. This 
shows you the estimated runtime and messages.

f) You should see the confirmation that the migration is completed. Choose Back as soon 
as the task is completed.
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Unit 1
Exercise 10

Validate Successful Data Migration

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Validate Data in Manage Banks Application
You will use the Manage Banks application to verify the data in your migration object template 
has been successfully migrated.

1. Navigate to the Manage Banks application to validate the Bank data has been migrated 
successfully.
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Unit 1
Solution 10

Validate Successful Data Migration

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Validate Data in Manage Banks Application
You will use the Manage Banks application to verify the data in your migration object template 
has been successfully migrated.

1. Navigate to the Manage Banks application to validate the Bank data has been migrated 
successfully.
a) Select the SAP logo in the upper left corner to navigate home to the launchpad.

b) Search for the Manage Banks app using the Search field and open it.

c) Select the Bank Country/Region filter options.

d) Search for CN.

e) Select the checkbox to the left of CN (China) and select OK.

f) Select the Go button below the filter fields.

g) You should see the data from your template populate in the list of banks.

h) Return to the homepage by choosing the SAP logo in the upper left corner.
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Unit 1
Exercise 11

Copy and Edit a Standard Test Automate 
Process

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Verify Launchpad Space is Assigned to Business Role & Assign Role to User
In this exercise, you will verify a launchpad space is assigned to the business role you will use 
in this exercise. When the Spaces and Pages home page is enabled, each business role must 
have an assigned launchpad space. Without a launchpad space, no apps will display on the 
launchpad for a user.

1. Verify there is a standard launchpad space assigned to the business role below and assign 
the role to your user.

● Administrator - Test Automation (BR_ADMIN_TEST_AUTOMATION)

Task 2: Copy and Edit a Test Process
You will copy and edit a test process in the Manage Your Test Processes application.

1. Open the Manage Your Test Processes application.

2. Make a copy of the Time Recording (1Q4) test process and save with the title: Time 
Recording ### (where ### is your user number).

3. Add the process step Time Recording through Manage My Timesheet below the original 
process step Record Actual Working Time.

4. Convert the Standard process step, Time Recording through Manage My Timesheet, to a 
Custom process step.
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5. Change the visibility to be Visible in Test Plan.

Unit 1: Implementing SAP S/4HANA Cloud Public Edition for Consultants: Exercises

© Copyright. All rights reserved. 48



Unit 1
Solution 11

Copy and Edit a Standard Test Automate 
Process

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Task 1: Verify Launchpad Space is Assigned to Business Role & Assign Role to User
In this exercise, you will verify a launchpad space is assigned to the business role you will use 
in this exercise. When the Spaces and Pages home page is enabled, each business role must 
have an assigned launchpad space. Without a launchpad space, no apps will display on the 
launchpad for a user.

1. Verify there is a standard launchpad space assigned to the business role below and assign 
the role to your user.

● Administrator - Test Automation (BR_ADMIN_TEST_AUTOMATION)

a) Select the Administration drop-down menu in the upper left and choose the Identity 
and Access Management page.

b) Open the Maintain Business Roles app.

c) Use the search to find the business role listed in the exercise.

d) Select the business role in order to open its detail page.

e) Select the Launchpad Spaces tab.

f) If there is a space assigned, skip to step k) to assign yourself permission to the role. If 
there is no space assigned, continue with the remaining steps.
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g) Select the Edit button.

h) Select Add.

i) There should be a launchpad space provided based on the predefined space. If not, 
select Use Predefined Space from the dropdown list and select the space 
SAP_BR_ADMIN_TEST_AUTOMATION.

j) Select Create and Assign Space.

k) Select the Business Users tab.

l) Select the Edit button, if not done already before.

m) Select Add.

n) Select the checkbox to the left of your user and select Apply.

o) Select OK to close the dialog box.

p) Select Save.

q) Refresh your browser.

r) Select the SAP logo in the top left corner to navigate home.

Task 2: Copy and Edit a Test Process
You will copy and edit a test process in the Manage Your Test Processes application.

1. Open the Manage Your Test Processes application.
a) Select the Automated Testing space.

b) Open the Manage Your Test Processes app.

2. Make a copy of the Time Recording (1Q4) test process and save with the title: Time 
Recording ### (where ### is your user number).

a) Use the search field to locate the Time Recording (1Q4) test process.

b) Select the test process.

c) Select Copy in the lower right corner.

d) Enter the test process name as defined in the exercise.

e) Select Save.

3. Add the process step Time Recording through Manage My Timesheet below the original 
process step Record Actual Working Time.
a) Select the Edit button in the lower right corner of the test process.

b) Select the checkbox to the left of the existing process step.

c) Select Add below from the far right, then Add UI Step.

d) Select the input help icon in the Name field of the new step.

e) Search for the process: Time Recording - Project-Based Services.

f) Select the Time Recording - Project-Based Services process, then select the process 
step: Time Recording through Manage My Timesheet.
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4. Convert the Standard process step, Time Recording through Manage My Timesheet, to a 
Custom process step.
a) Select the checkbox to the left of the Time Recording through Manage My Timesheet 

process step.

b) Select Change Type from the far right.

c) Select OK to confirm changing the type.

d) Select Save in the lower right corner.

5. Change the visibility to be Visible in Test Plan.
a) Select Change Visibility in the lower right corner.

b) Select the SAP logo in the upper left corner to navigate home to the launchpad.

Solution 11: Copy and Edit a Standard Test Automate Process
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Unit 1
Exercise 12

Create a Test User

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Create a Test User
You will create a default test user for the Automated Testing Tool to use during execution of 
the business process tests.

1. Open the Test Your Processes application.

2. Create a test user with the following information:

● Role: DEFAULT_### (where ### is your user number)

● Description: Default Test User ### (where ### is your user number)

● User Type: Business User

● User Name: Select the A00### user (where ### is your user number) that you are 
currently logged-in with.

● Password: <the password you got for user A00###>
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Unit 1
Solution 12

Create a Test User

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Create a Test User
You will create a default test user for the Automated Testing Tool to use during execution of 
the business process tests.

1. Open the Test Your Processes application.
a) Select the Automated Testing space.

b) Open the Test Your Processes app.

2. Create a test user with the following information:

● Role: DEFAULT_### (where ### is your user number)

● Description: Default Test User ### (where ### is your user number)

● User Type: Business User

● User Name: Select the A00### user (where ### is your user number) that you are 
currently logged-in with.

● Password: <the password you got for user A00###>

a) Make sure you have Customer Tests selected in the Test Plans area.

b) Select the User Settings icon in the lower left area of the screen, then select Maintain 
Roles.
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c) Select the plus (+) button in the upper right to add a new user.

d) Enter the information listed in the exercise and select Validate and Save.

e) Select the SAP logo in the upper left corner to navigate home to the launchpad.

Unit 1: Implementing SAP S/4HANA Cloud Public Edition for Consultants: Exercises

© Copyright. All rights reserved. 54



Unit 1
Exercise 13

Create a Test Plan

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Create a Test Plan
You will create a test plan and assign the custom test process created in a previous exercise 
to the plan.

1. Open the Test Your Processes application.

Note:
If you are directed to the Manage Your Solution application instead of directly 
to the Test Your Processes application, please select Test Your Processes 
within Manage Your Solution. You can then continue with the remaining 
exercise steps.

2. Create a new test plan with the following information:

● Test Plan Name: Adapted Time Recording Test ### (where ### is your user 
number)

● Test Process: Time Recording ### (created in a previous exercise)
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Unit 1
Solution 13

Create a Test Plan

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Create a Test Plan
You will create a test plan and assign the custom test process created in a previous exercise 
to the plan.

1. Open the Test Your Processes application.
a) Select the Automated Testing space.

b) Open the Test Your Processes app.

c) In case you see an empty screen, refresh your browser.

Note:
If you are directed to the Manage Your Solution application instead of directly 
to the Test Your Processes application, please select Test Your Processes 
within Manage Your Solution. You can then continue with the remaining 
exercise steps.

2. Create a new test plan with the following information:

● Test Plan Name: Adapted Time Recording Test ### (where ### is your user 
number)

● Test Process: Time Recording ### (created in a previous exercise)
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a) Make sure you have Customer Tests selected in the Test Plans area.

b) Select the plus (+) icon in the lower left area of the screen.

c) Use the keyword search on the right to locate your Time Recording ### test process 
created in a previous exercise.

d) Select the checkbox to the left of your test process.

e) Enter the test plan name as given in the exercise.

f) Select Save in the lower right corner.

Note:
You will not execute the test plan in this exercise because the training 
system is not connected to an SAP Cloud Identity tenant. A connection 
with the identity tenant is required for the test execution service to 
generate the virtual test user and allow it to be authenticated to complete 
the test plan steps.

g) Select the SAP logo in the upper left corner to navigate home to the launchpad.

Solution 13: Create a Test Plan
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Unit 1
Exercise 14

Provide Consent for Post-Upgrade Testing by 
SAP

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Provide Consent for Post-Upgrade Tests (PUTs)
This exercise is to demonstrate how to provide consent for post-upgrade testing if a customer 
chooses to use this service from SAP in their Quality system. Post-upgrade testing is only 
available for live customers, and is done for a limited set of SAP S/4HANA Cloud Public 
Edition processes. Test cases are selected based on a customer's active standard business 
processes (scope items), availability of data, and the apps covered by the tests. Post-upgrade 
testing can only be done for standard processes, meaning no extensions were made to the 
process or apps within the process flow. All test plans created as part of the post upgrade test 
are system generated test plans, and are executed once by SAP each quarter. The data 
needed to run post-upgrade test plans is read automatically in the customer’s Quality system. 
Results of executed test plans are visible in the Analyze Automated Test Results application 
and the Test Your Process application. Post-upgrade test plans can also be copied and be 
executed further by the customer, if needed.

1. Open the Test Your Processes application.
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Note:
If you are directed to the Manage Your Solution application instead of directly 
to the Test Your Processes application, please select Test Your Processes 
within Manage Your Solution. You can then continue with the remaining 
exercise steps.

2. Provide consent for post-upgrade tests conducted by SAP.

Exercise 14: Provide Consent for Post-Upgrade Testing by SAP
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Unit 1
Solution 14

Provide Consent for Post-Upgrade Testing by 
SAP

Training System Access

Note:
An SAP S/4HANA Cloud Public Edition training system is required to complete the 
following exercise. To get a training system, complete the following steps:

1. Purchase a subscription for SAP Learning System Access.

2. Search for course code S4C01 here.

3. Select +Enroll for the SAP S/4HANA Cloud Public Edition system assigned to 
S4C01.

Note:
Some exercises use the characters ### as placeholders for your three digit user 
number. Please use your assigned three digit user number whenever you see ### 
in an exercise.

Provide Consent for Post-Upgrade Tests (PUTs)
This exercise is to demonstrate how to provide consent for post-upgrade testing if a customer 
chooses to use this service from SAP in their Quality system. Post-upgrade testing is only 
available for live customers, and is done for a limited set of SAP S/4HANA Cloud Public 
Edition processes. Test cases are selected based on a customer's active standard business 
processes (scope items), availability of data, and the apps covered by the tests. Post-upgrade 
testing can only be done for standard processes, meaning no extensions were made to the 
process or apps within the process flow. All test plans created as part of the post upgrade test 
are system generated test plans, and are executed once by SAP each quarter. The data 
needed to run post-upgrade test plans is read automatically in the customer’s Quality system. 
Results of executed test plans are visible in the Analyze Automated Test Results application 
and the Test Your Process application. Post-upgrade test plans can also be copied and be 
executed further by the customer, if needed.

1. Open the Test Your Processes application.
a) Select the Automated Testing space.

b) Open the Test Your Processes app.

c) In case you see an empty screen, refresh your browser.
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Note:
If you are directed to the Manage Your Solution application instead of directly 
to the Test Your Processes application, please select Test Your Processes 
within Manage Your Solution. You can then continue with the remaining 
exercise steps.

2. Provide consent for post-upgrade tests conducted by SAP.
a) Select the Post-Upgrade Tests area from the Test Plans screen.

b) Select the Consent for Post-Upgrade Test icon in the lower left area of the screen.

c) Review the consent information.

d) Select Confirm. Note, that if you are only offered to withdraw, the confirmation has 
already been given. In this case choose Cancel and exit the screen to finalize the 
exercise.

e) Select the checkbox to agree to post-upgrade testing by SAP.

f) Select I agree and exit the screen using the SAP icon in the upper left corner.

Solution 14: Provide Consent for Post-Upgrade Testing by SAP
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